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 EndNote Tips      

 
Tip 1: Have only one EndNote library. Use the Groups feature to group references. 
 
Tip 2: Keep a copy of your EndNote library and back it up regularly. 

 
 

AGLC3 online 

To see the rules in full the online version of The Australian Guide to Legal Citation (3rd edition) is available at: 

http://www.law.unimelb.edu.au/mulr/aglc. The hard copy version is available in Curtin Library at the shelf 

number: 808.06634 AUS. To check availability and see locations go to the Curtin Library Catalogue. It is a good 

idea to familiarise yourself with 'Part 1: General Rules' as it outlines the essence of the referencing style and will 

give you a good foundation. It also gives you lots of useful examples. 

 

 

http://www.law.unimelb.edu.au/mulr/aglc
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What is EndNote? Why is it useful? 

EndNote is ‘personal bibliographic software’ and it enables you to store all your references in your own database 

(‘Library’), insert citations from it into your Word document,  then automatically produce your reference list in a 

particular referencing style, saving you much time. 

 

Downloading EndNote X8 

Curtin students can download EndNote X8 from OASIS (the MyLibrary tab) OR from the Library’s EndNote 

Libguide (http://libguides.library.curtin.edu.au/endnote). 

  

 After logging in and following the instructions, you should have EndNote downloaded into the 

C:\Program Files area of your computer. 

 You can have EndNote X8 loaded onto each computer that you will be using. 

 If is advisable to download any updates.  Go to the Help menu and select EndNote Program Updates…. 

 
Creating an EndNote Library 

 Open the EndNote program 
 Go to File > New 
 Choose a location to save your EndNote Library and name it 

It’s important that you only ever have ONE Endnote Library for all your citations. You can use the Groups feature 
on page 13 to help you sort your information according to the unit you’re studying or the assignment you are 
writing.  

Creating a custom Legal reference type 

EndNote comes with ‘legal’ reference types (such as Statute, Legal Rule/Regulation, Hearing, Case, Bill), however 

we can’t use these reference types because the formatting of a citation for a statute, case, etc. varies according to 

the jurisdiction. So you would need reference types for Australian Statute, UK Statute, Canadian Statute, US 

Statute, etc.  

Instead, we use a single Legal reference type. You can use this one reference type for all your legal citations. 

Follow these steps to set up your custom Legal reference type: 

• In EndNote click on Edit on the menu bar. Then click on Preferences. 

• Click on Reference Types in the left-hand frame. Now in the right-hand pane, click on the Modify 

Reference Types button. 

• In the Reference Type box at the top of the window, use the drop-down menu to select Unused 1. This 

will display the blank Unused 1 reference type. 

• Click in the Generic box and change the name of Unused 1 to Legal. 

• Fill in the following boxes in the screenshot below with the following information: 

 

 

http://libguides.library.curtin.edu.au/endnote
http://libguides.library.curtin.edu.au/endnote
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Generic Legal 
Author  
Year Year 
Title AGLC Citation 
Secondary Author Jurisdiction 
Secondary Title  
Place Published  
Publisher  
Volume  
Number of volumes  
Number  
Pages  
Section  
Tertiary Author  
Tertiary Title  
Edition  
Date  
Type of work  
Subsidiary Author  
Short Title Short Title 
Alternate Title  
ISBN/ISSN  
DOI  
Original Publication  
Reprint Edition  
Reviewed Item  
Custom 1  
Custom 2  
Custom 3  
Custom 4  
Custom 5  
Custom 6  
Custom 7  
Custom 8  
Accession Number  
Call Number  
Label Label 
Keywords Keywords 
Abstract Abstract 
Notes Notes 
Research Notes Research Notes 
URL URL 
File Attachments File Attachments 
Author Address  
Image  
Caption  
Access Date  
Translated Author  
Translated Title  
Name of database  
Database Provider  
Language  

• Click on the OK button to confirm these changes. 

• This will return you to the EndNote Preferences window. Click on the OK button to close this window. 
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Entering Legal References 

The Legal reference type is to be used for Cases, Legislation, Treaties and all other references which do not fit into 
one of the reference types listed in the table on page 5.  

Year  

This field is optional. The output style will not use it when formatting your references. However you may find it 
useful when searching your library or sorting your references.  

AGLC Citation  

Enter the complete citation in the form specified by AGLC3 (see the library’s AGLC Referencing Guide for help in 
constructing these citations). Capitals, italics and superscript must be supplied. For italics, highlight the relevant 
text and click on the Italics button on the toolbar at the top of the New Reference window. For superscript, 
highlight the relevant text and click on the Superscript button on the toolbar.  

Do not insert a full stop at the end of the citation. You will add the full stop and any relevant pinpoint citation 
when you insert the reference in your document.  

Jurisdiction  

This field is optional. However you may find it useful when searching your library or sorting your references. You 
can use the full name of the jurisdiction or a standard abbreviation. The output style will not use this data when 
formatting your references.  

Abbreviated and Popular Names  

In repeat citations, it is common to use abbreviated or popular forms of case names (AGLC3 2.1.14), legislation 
(AGLC3 3.9.1) and treaties (AGLC3 7.6.20).  Insert the abbreviated or popular form in the Short Title field:

 

 
  

See page 17 for more. 
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Entering non-legal references for use with the AGLC referencing style 

If you are referencing a source other than a case, legislation or treaty then you may use the following reference 

types with guidelines. For the output style to format your references correctly, the data must be entered correctly 

in your EndNote library as in the examples below:  

 

All reference types 
(including Legal) 

Author 
• Enter each author on a separate line. 
• Enter the author's name as it appears on the publication. Note that 

initials should be entered with spaces and no fullstops, e.g.  
Campbell, Enid  
Hart, H L A 

• Include 'Sir', 'Dame', peerage titles and judicial titles (AGLC3 1.14.1, 
1.14.4) in the author field, e.g.  
Mason, Sir Anthony  
Kirby, Justice Michael 

• If the author is a corporate body place a comma at the end, e.g 
Victorian Law Reform Commission, 

• However, if there is a comma within the corporate name, the comma 
should be duplicated, and no final comma is required. Examples:  
Law Reform Committee,, Parliament of Victoria  
Commonwealth,, Royal Commission into Aboriginal Deaths in Custody  
The redundant comma will not appear in the formatted reference. 
 

Label 
AGLC3 requires that your reference list be divided according to the 
type of material. To do this, you must enter a category in the Label 
field of each of your references. The output style will sort your 
reference list by the Label field, so that the references will be 
grouped in categories. Then references are sorted by the first 
author, or, if there is no author, by title. In the Label field of each 
reference, enter one of the categories specified in AGLC3:  
A Articles/Books/Reports  
B Cases  
C Legislation  
D Treaties  
E Other 
The references will appear as a single block at the end of your 
document, grouped according to the categories. You will need to 
remove the EndNote field codes, insert some blank lines between 
each category and add an appropriate heading to each group. 
 

Pinpoint citations 
This is for your reference only if you wish to record particular 
pages, paragraphs or sections. You can then refer to this 
information when inserting your pinpoint references. 

 
Journal Article For journal articles which are available only on the web, use the Electronic 

Article reference type (not journal article). If a journal article is readily 
accessible in printed form, it should be cited as a printed item, even if it was 
viewed on the web (AGLC3 4.9). 
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Author 
See above. 
 

Year 
Enter the year here, however see the note below on Volume. 

 
 
Title 

Enter the title of the article. Capitalise the first word and all other 
significant words. Do not enclose the title in quotation marks: the 
output style will do this for you. If the name of a case or statute is 
included as part of the title, you must italicise the case or statute 
name when entering the title. 
 

Journal 
Enter the title of the journal in this field, omitting 'The' if it occurs 
at the beginning of the title. Capitalise all significant words. Enter 
the journal title in full: no abbreviations are to be used for journal 
titles. Do not italicise the title as the output style will do this for 
you. 
 

Volume 
Enter the volume number in this field. If the journal does not have 
volume numbers, and is identified only by year, enter the year here 
in square brackets and leave the Year field blank. 
 

Issue 
AGLC3 requires an issue number only for journals where the 
pagination of each issue begins at page one. Where pagination is 
continuous across the issues of a volume, do not enter the issue 
number. In some situations the issue details must be entered in the 
Date field (see below). 
 

Pages 
AGLC3 requires that only the first page number be cited. Insert that 
here. 
 

Date 
Use the Date field in two situations only:  
• For journals where the pagination of each issue begins at page one, 
but there is no numerical designation of the issue. Enter the name of 
the season or month in the Date field. 
 
• For journals where the pagination of each issue begins at page one, 
and there is no volume number, so a year has been entered in the 
Volume field in square brackets. In such instances, enter the 
designation for the issue (whether a number, a month or a season) in 
the Date field.  
 

URL 
Do not enter data in this field. If a journal article is readily accessible in 
printed form, it should be cited as a printed item, even if it was viewed 
on the web (AGLC3 4.9).  
For journal articles that are accessible only on the web you should use 
the Electronic Article reference type. 
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Book The Book reference type can normally be used for parliamentary papers, 
parliamentary committee reports, Command papers and reports of royal 
commissions and law reform commissions.  
 
Year 

If the book is a multivolume set published over a range of years, enter 
the first and last years if the work is complete, e.g. 1970-93 
When citing a later edition of a classic work, leave this field blank 
and enter the date of the edition being used in the Edition field.  

 
Title 

Capitalise the first word and all significant words. 
 

Series Title 
Enter where the series title and number are particularly important in 
identifying the work. Enter the title of the series and the number, e.g.  
Report No 40  
Parl Paper No 142  
 

Edition 
Enter only the ordinal number; the output style will add “ed” 
afterwards. AGLC3 requires that you superscript the ordinal suffix. To 
do this, highlight the suffix, and then click on the Superscript button on 
the toolbar at the top of the New Reference window. The field will 
now look like this: 2nd  
If there is no edition number, you can insert other appropriate text, 
e.g. revised  
In the case of classic works, the date of the edition being used should 
be entered in this field, and the Year field should be left blank. The 
date of the first edition is inserted in the Original Publication field. 
 

City 
Not required. See AGLC3 5.3.1. 
 

Publisher 
Use a brief version of the publisher's name (AGLC3 5.3.1). In the case 
of government publications, the publisher is often the same as the 
author; in such cases leave the Publisher field blank. 

 
Newspaper Article Electronic newspapers should only be cited where an identical printed edition 

(of the newspaper or the article cited) does not exist (6.5.3). 
 
Reporter 

Enter reporter names in the same way as author. If the article is an 
editorial, enter the word Editorial in the Reporter field. 
 

Year 
Enter year of article here. 
 

Title 
Enter the title of the article. Capitalise the first word and all significant 
words. Do not enclose the title in inverted commas: the output style 
will do this for you. 
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Newspaper 
Enter the full title of the newspaper, including the word 'The' where it 
appears in the masthead. Capitalise the first word and all significant 
words. Do not italicise the title: the output style will do this for you.  
If the article appears in a separately paginated section of the 
newspaper, and the section has its own title, the title of the section 
should precede the title of the newspaper (AGLC3 6.5.1), e.g.  
Saturday Extra, The Age 
 

City 
If the city is outside Australia, add the country, e.g. Toronto, Canada  
If you viewed the article online, do not enter a city name in this field. 
Instead, insert: online 
 

Pages 
Enter the page number, or section and page number, e.g. B6 
 

Issue Date 
Enter the day and month, e.g. 5 February 
 

URL 
If the newspaper article is only available online (and not in print), enter 
the URL in this field. 

Conference 
Proceeding 

• For unpublished conference papers use the Conference Proceedings 
reference type.  

• A published volume of conference proceedings should be entered as 
an Edited Book.  

• A single paper in such a volume should be entered as a Book Section. 
Report Use this reference type for working papers (AGLC# 6.9) 

 
Web page Note that if an item exists in printed form, it should be cited as a printed item 

using the appropriate reference type, even if it was viewed on the web (AGLC3 
6.15). For journal articles that are accessible only on the web you should use 
the Electronic Article reference type (see 3.12 below). For online versions of 
newspaper articles, conference proceedings, reports and theses, use those 
reference types. 
 
Year 

The output style will ignore any data entered in this field. See Last 
Update Date. 

 
Publisher 

If the page being cited is part of a larger website, enter the name of 
the website here. Often this will be the name of the organisation 
responsible for the website, but it may be a title, or both an 
organisation and a title. If the data in this field would be identical with 
the data in the Author field, leave this field blank (AGLC3 6.15.4). 
 

Last Update Date 
If the webpage gives a date of last update, or failing that, a date (or 
year) of creation, enter the information here, e.g. 29 September 1995 
or May 2009 or 2010.  
 
This information may be difficult to ascertain. Look for a copyright 
date, often to be found at the bottom of the web page. If no date can 
be ascertained, or if the page is being continually updated, leave this 
field blank. 
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URL 
Enter the URL of the web page. Do not enclose it in angle brackets: the 
output style will do this for you. Note that AGLC3 does not require that 
you cite a date of retrieval (AGLC3 6.15.6).  
 
Where the full URL is very lengthy and the document may be easily 
located from a homepage or index page of the website, it is sufficient 
to enter the URL of the homepage or index page (AGLC3 6.15.6). 
 

Electronic Article Use this reference type for journal articles which are available only on the web. 
If a journal article is readily accessible in printed form, it should be cited as a 
printed item, even if it was viewed on the web (AGLC3 4.9). 
 
Title 

Enter the title of the article in this field. Capitalise the first word and all 
other significant words. Do not enclose the title in quotation marks: 
the output style will do this for you. If the name of a case or statute is 
included as part of the title, you must italicise the case or statute name 
when entering the title. Highlight the case or statute name and click on 
the Italics button on the toolbar at the top of the New Reference 
window. (Alternatively, use the standard shortcut Ctrl+I to italicise 
text.) 
 

Periodic Title 
Enter the title of the journal in this field, omitting 'The' if it occurs at 
the beginning of the title. Capitalise all significant words. Enter the 
journal title in full: no abbreviations are to be used for journal titles. 
Do not italicise the title as the output style will do this for you. 
 

Pages 
Journals which are available only on the web do not usually have any 
continuous pagination. If such data is available, enter it here. 
 

URL 
Enter the URL here. Do not enclose it in angle brackets: the output 
style will do that for you. Note that AGLC3 does not require that you 
cite a date of retrieval (AGLC3 4.9). 

 

You may also use the reference types of Thesis, Edited Book and Book Section however this reference style is not 

configured to format any other EndNote reference types. Do not use EndNote's Hearing, Bill, Statute, Case and 

Legal Rule/Regulation reference types (use the custom legal reference type which you set up for this purpose). 

Building your library of references There are several ways to build your EndNote library including: 

 Typing references 

 Searching databases and directly exporting the references into EndNote. 

 Using a filter (for databases that do not allow for direct export or do it inadequately). 

 Using EndNote connection files to search Library catalogues such as the Curtin Library catalogue 

and downloading the references for your textbooks, videos, theses etc. 

 Importing and creating basic records from PDF files. 
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Adding references to your Library manually. 

 In EndNote, in the top menu bar, click References and choose New Reference or use the icon  

This opens a blank "New Reference" template for you to type the information into the appropriate fields. 

 

 From the Reference Type dropdown menu, choose the appropriate Reference Type (e.g. Book, Journal 

Article, Legal) for your item. The fields will change in the template according to the reference type you 

choose. 

 

 Type the information into the relevant fields of the template. (Check the Library’s Guide to AGLC3 

Referencing for essential fields. For the URL of this document see the box at bottom of this page). 

 

 Save a reference by just closing it!  ( X) (Remember it is the second x from the top right).  EndNote will ask 

you if you want to save changes. Click Yes. 

 
 
Please Remember: 
 
 Author names:  each author is on a separate line in the Author field. If you enter the family name first, place 

a comma after it e.g.  

     Smith,  J L 

     Hall, Marianne 

Use correct capitalisation e.g. van den Burgh, Sophie 

 

 Names of organisations (Corporate authors) :  place a comma after the name so that EndNote recognises 

which name to list in the reference list e.g.  

Curtin University. Graduate School of Business,  

Woodside Australia,  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

We recommend that you print out Curtin Library’s Guide to AGLC3 Referencing available at: 

http://lgdata.s3-website-us-east-

1.amazonaws.com/docs/1470/765665/AGLC3_Referencing_Long_Guide_with_masthead.pdf 

Keep this with you when you are referencing and refer to it as you go along. It has many examples 

with explanations which should made things clearer for you. 

http://lgdata.s3-website-us-east-1.amazonaws.com/docs/1470/765665/AGLC3_Referencing_Long_Guide_with_masthead.pdf
http://lgdata.s3-website-us-east-1.amazonaws.com/docs/1470/765665/AGLC3_Referencing_Long_Guide_with_masthead.pdf
http://lgdata.s3-website-us-east-1.amazonaws.com/docs/1470/765665/AGLC3_Referencing_Long_Guide_with_masthead.pdf
http://lgdata.s3-website-us-east-1.amazonaws.com/docs/1470/765665/AGLC3_Referencing_Long_Guide_with_masthead.pdf
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Previewing your references in AGLC3 referencing style.  

 

Previewing lets you check if a selected reference displays correctly in a particular referencing style. 

 

 Click on the Preview tab to display the Preview window. 

 Go to the styles drop-down window and choose Select Another Style, navigate to 

AGLC3_footnotes_and_reference_list, highlight it and click Choose.  

 Preview your references in the AGLC3_footnotes_and_reference_list style by clicking on a reference and 

see how it appears in the Preview window. If the information appears incorrect, change the details for 

that book, journal article etc.  in your EndNote Library. 

 

NOTE: regardless of whether you are expected to produce a reference list or not, to preview references in 

EndNote you must choose the AGLC3_footnotes_and_reference_list style. The AGLC3_footnotes_only style will 

not give you a preview as EndNote does not preview the footnote. EndNote only previews the reference list. 

 

 

To attach a PDF file to an EndNote reference 

 

1. Save the PDF to your desktop (suggest -with the author name as the file name). 

2. Open your EndNote Library. Open the reference. 

3. Scroll down to the File Attachments field, right click>File Attachments>Attach File… alternatively click 

the paper clip icon. 

4. Navigate to the PDF, click Open and the PDF will open in the PDF viewer.   When you click outside this 

you will be asked to save the changes then the paper clip icon will appear next to the reference.  The 

PDF will be found in the File Attachments field. 
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Direct Export of journal article references from databases 

If you are searching databases for scholarly journal articles on a topic, the easiest way to add them to your 

library is using the direct export function.  Look for words like ‘export’ or ‘bibliographic software’ in the 

database, once you have your results, to see if this option is available.  

 

For a list of databases that have direct export, go to Curtin Library’s EndNote X8 LibGuide>Direct Export & 

Filters Tab and find the PDF link to: Using Direct Export with EndNote and databases. 

 

Direct Export from the Business Source Complete database 

Business Source Complete is a leading scholarly business database and indexes the most important scholarly 

business journals.  

 

From the Taxation LibGuide at: http://libguides.library.curtin.edu.au/taxation go to the Journals & databases tab 

and select Business Source Complete database and login. 

 

Our topic is: Taxpayer compliance and Australia 

1. In the first search box type:  taxpayer compliance. 

2. In the second search box type: Australia.  Click Search. 

3. On the results screen, check the Academic Journals box and update. 

4. Choose 2-3 full text article references by clicking Add to folder. 

5. (Save a PDF from one of the references you intend to select to your desktop –for the class). 

6. Click on Folder [top right] or Go to: Folder View [right hand side]. 

7. Tick Select and then click on Export. 

8. Select Direct Export in RIS Format (e.g.  EndNote etc…) and the Save button. 

9. If prompted by EndNote, choose Open. 

10. Your imported references will appear in your open library in a temporary window where you can check the 

reference details. 

11. You should preview these features in the AGLC3 style and amend the references if required. Check that the 

author names have exported correctly and are on separate lines. 

12. URL or no URL? 

If a journal article is readily accessible in printed form, it should be cited as a printed item, even if it was 

viewed on the web (AGLC3 4.9). Although the URL does transfer across, EndNote will automatically not 

display it. For journal articles that are accessible only on the web you should use the Electronic Article 

reference type. By changing your reference to this, the URL will display. 

 

 NOTE:  

The imported references (and any amendments you have made to them), are automatically merged into your 

library under ‘All References’.   New references you export will overwrite the previous ‘imported references’. 

http://libguides.library.curtin.edu.au/taxation
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Using the Groups feature to group references by your subject terms  

As the Groups feature can be used to identify references in separate subject areas, there is no need to create 

more than one EndNote library. (There are also other ways of labelling references). 

 

Creating a Group Set and Groups within it:  

 

• In the My Library window, clicking on All References shows your whole library. 

• If you have just imported some references from a database, they will be listed under Imported References 

until you close your library or import some more. 

• To create a Group Set within which to place your groups: e.g. Current Topics in Taxation,  go to 

Groups/Create Group Set and name it.  

•  To create a Group within the Group Set, go to Groups/Create Group or right click on the Group set name and 

select Create Group and call it e.g.  First Assignment. 

• To allocate references to a Group, first click to highlight the reference/s. 

• Go to Groups/Add References To…..and click on the appropriate Group’s name –or right click on the 

reference/s, select Add References To and click on the appropriate group. 

• [You can also highlight a reference in your library and drag it into a group]. 

• Click on All References to go back to the whole library. 

• Click on the Group’s name to see references belonging to it. 

• You can have the same reference in as many groups as you wish.  

• To see which group/s your reference belongs to, right click and choose Record Summary. 

 

The Groups feature will help you to keep separate references used for units of study which require a different 

referencing style from other units. 
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Inserting citations into your Word documents 

AGLC requires all your in-text citations to appear as footnotes in your Word document. Footnotes are used to:  

• Acknowledge sources of information you have used in your assignments, and  

• Provide information that enables the reader to find the sources that you used.  

Any direct quotes in your assignment must be immediately followed by a footnote. You must also always include 

a footnote when you have paraphrased from a source. 

 
 To insert a footnote in Word 

• Open your Word document. Place your cursor where you want the footnote to appear. The footnote 

should appear directly after the full stop in the text of your Word document (rule 1.1.2). Position your 

cursor at the appropriate place. 

•  Click on the Reference Tab within Word.  

• Then click on Insert Footnote. 

• Then go to EndNote and select the reference you wish to insert. 

• Use the Insert Citation button in the toolbar in EndNote:    or Alt + 2. (If you are using a Mac  ) 

• If you wish to cite a second reference in the same footnote, type a semicolon and a space before inserting 

the second reference (repeating the steps above). For example: 
1 Wong v Commonwealth (2000) 236 CLR 573, 200; Crimes Act 1958 (Vic) s 3. 

• At the end of each footnote, type a full stop. 

 

 
 

 

Changing referencing styles 

EndNote comes with hundreds of referencing styles, but only a few of these display automatically in the drop-

down style menus.  To format your reference list in a style that does not initially appear in Word: 

 In the Bibliography Group, click on the drop down arrow in the Style:  box. 

 Choose “Select Another Style…”  and from the menu select e.g. AGLC3_footnotes_and_reference_list.  

 Click OK.  Your footnotes and the reference list will be reformatted in your chosen referencing style. 

 

NB: Please check with your lecturer whether they require you to produce a reference list. If they do then you need 

to choose the AGLC3_footnotes_and_reference_list style. It they only want footnotes then you need to choose 

the AGLC3_footnotes_only style. 

1. Click on the References tab 

2. Click on Insert Footnote 
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Pinpoint Citations 

 

A pinpoint reference is a reference to a specific page or paragraph within a footnote. A pinpoint reference to a 

page should appear as a number. A pinpoint reference to a paragraph should appear as a number in square 

brackets. It is placed at the end of the footnote and should be preceded by a space. For example:  

 

H L A Hart, The Concept of Law (Clarendon Press, 1970) 15 [2].  

 This example provides a pinpoint to both a page and a paragraph number. 

 

For journal articles and cases you are required to place a comma before the pinpoint citation. For example:  

Gordon Goldberg, ‘Confusions Concerning Common Count’ [2000] Restitution Law Review 189, 67.  

 

To add a pinpoint citation right-click on the reference in the footnote and select the Edit Citation(s)>More 

command.  

 

When the Edit Citation(s) window opens, find the Suffix box. (Note: Do not use the Pages box). Enter the required 

data in the Suffix box. Remember that AGLC3 sometimes requires a comma before the pinpoint citation, e.g. for 

journal articles, Australian cases, UK legislation. If no comma is required you need to start with a preceding space 

and then add the page number. If a comma is required you need to start with a comma, enter a space and then 

add the page number. For example: 

 

 

 

Repeat Citations 

 

Repeat citation in immediately following footnote (all reference types) 

When you cite a work that has already been cited in the previous footnote, EndNote will insert the text 'Ibid'. If 

necessary you can then edit this citation to add a pinpoint reference (see above).  
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Repeat citation in a later footnote (books and journal articles) 

 

If you insert a later reference to a book or journal article (but not a case or legislation) which has been previously 

cited in the document, it will appear in the form “Smith, above n ”  

 

You then need to insert the number of the footnote in which the reference was previously cited. To do this, use 

Microsoft Word's cross-reference function: click on the Insert tab on the ribbon, and select Cross-Reference.  

You will now see the Cross-reference dialogue box. Under Reference type select Footnote, and under Insert 

reference to select Footnote number. You will see a list of footnotes, and you can highlight the appropriate 

footnote which you want to be cross referenced: 

 

 
 

Now click on the Insert button to insert the cross-reference. Close the dialogue box and return to the footnote. If 

required, type the details of the pinpoint citation at the end of the footnote.  

 

The advantage of using Word's cross-reference function is that you can easily update the cross-references if your 

footnote numbers change. When you revise your document, you may add or delete footnotes, causing the 

footnotes to be renumbered. To update your cross-references to reflect the new numbering, click anywhere in 

the footnotes and press Ctrl+A to select all the footnotes. Now press the F9 key, and all of the cross-references 

will be updated.  

 

You should also use this procedure when the reference was cited in the immediately preceding footnote, if other 

references were also cited in that footnote. 
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Repeat citation in a later footnote (case, legislation or treaty) 

 

Repeat citations for a case, piece of legislation or treaty are treated differently. If the reference is cited in a later 

footnote (but not the footnote immediately following), EndNote will insert the full citation again.  

 

However if you are using an abbreviated or popular name for repeat citations to the case, (so the reference in 

your EndNote library contains a Short Title – see page 4 ‘Abbreviated and Popular Names’) this citation will be 

used. If the reference does not contain a Short Title, EndNote will insert the normal citation.  

 

For example: 

 

First citation: Commonwealth v Tasmania (1983) 158 CLR 1 (‘Tasmanian Dam Case’). 

Repeat citation: Tasmanian Dam Case (1983) 158 CLR 1. 

 

NB: After inserting the first citation into the footnote, using EndNote, you will need to manually type in at 

the end the abbreviated name, italicised, in single quotation marks and in brackets. In the example above, 

you would need to type in (‘Tasmanian Dam Case’). 

 

If the repeat citation names the case or treaty in the text, the name should be omitted from the footnote. 

 

 

Examples of using ‘Ibid and ‘above n’  

 

1 Eric Barendt, Freedom of Speech (Oxford University Press, 2nd ed, 2005) 163.  

2 Ibid.  

3 Ibid 174-5.  

4 Catharine MacMillan, Mistakes in Contract Law (Hart Publishing, 2010) 38.  

5 Defamation Act 2005 (Vic) s 37.  

6 MacMillan, above n 4. 
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Reference List 

 

The first step is to check with your lecturer whether they require you to produce a reference list. It may be the 

case that footnotes are sufficient.  

 

AGLC3 requires that your reference list be divided according to the type of material. To do this, you must enter a 

category in the Label field in EndNote for each of your references. The AGLC style will sort your reference list by 

the Label field, so that the references will be grouped in categories. Then references are sorted by the first 

author, or, if there is no author, by title. In the Label field of each reference, enter one of the categories specified 

in AGLC3: 

A Articles/Books/Reports 

B Cases 

C Legislation 

D Treaties 

E Other 

 

The references will appear as a single block at the end of your document, grouped according to the categories, 

however the headings are not automatically inserted. You need to insert these manually. To do this you will need 

to first remove the EndNote field codes.  

 

To do this: 

 

• Click on the EndNote tab in Word. 

• Look in the Bibliography group. 

• Click on the Convert Citations and Bibliography drop down arrow. 

• Choose Convert to plain text.  

• Next insert some blank lines between each category and add the appropriate heading to each group (as 

listed in your Label field in EndNote). This heading must be centred on the page and printed in italics (NB: 

the category letter is NOT in itallics). 

 

 Note:  If you spot any error in the reference list or in-text citations NEVER correct the mistake in Word.   

Correct the error/s in the individual records in your EndNote Library, then in Word choose Update citations 

and bibliography to reformat the text of your document with the corrected citation.  
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Moving your EndNote Library between computers 

If you are working on your home computer and on a Curtin computer you will need to update your 

EndNote library in each location. That is, when you add references or other information to your library 

in one location you will need the library in the other location to be similarly updated. The best way to do 

this is to over-write your library. 

 

Method 1: Saving your library as a compressed file 

You can save your complete library (the .enl  file as well as its associated .DATA folder) to a single 

compressed .enlx file.  You can move this file between computers and then unzip the compressed 

library with EndNote. You can also email your library as a compressed file attachment. 

 

To save a compressed library file: 

• Open your library in EndNote. 

• From the “File” menu, select “Compressed Library.enlx”. 

• Save as an .enlx file. (e.g. to your USB to work on elsewhere). 

 

To restore/open a compressed library file: 

• In your USB etc, double click on the .enlx file to extract both the .enl file and the .data folder to 

your preferred location. 

•  If asked if you want to overwrite (as the file already exists) say Yes. 

• Use EndNote to open the .enl  file as you normally would to use the library. 

 

Method 2: Copy and paste 

• Insert a USB in the computer you are using. 

• From the Computer’s folder list…. 

• select the EndNote library icon and the .data folder icon (with the same name as your library) in 

the location you have made updates 

                                               Sample data 

• Right click and select Copy. 

• Go to your USB disk drive. Right click and select Paste. 

• When you are at the computer in the other location repeat the icon selection and the right click 

Copy command. 

• Find the folder in where you keep your EndNote library, right click and select Paste. 

 

 Note: Whenever you move your library in this way, the computer will ask if you want to replace 

the existing files, you should click ‘Yes’.  
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For more help with AGLC 

• Go to the Taxation LibGuide and OR the Law LibGuide and open the Referencing tab.  

Here you will find: 

o The Library’s AGLC Referencing Guide. 

o The Library’s screen recordings demonstrating how to use AGLC with EndNote. 

 

For more help with EndNote 

• EndNote’s Help button. 

• The Getting Started Guide and EndNote.pdf manuals 

These extensive documents are in your C:\Program Files\EndNote X8 folder (or go to Start/All 

Programs/EndNote X8/Getting Started Guide) and on the welcome page of our EndNote LibGuide  

 To locate go to the Library home page, under Top Links, locate EndNote. 

•  The EndNote website http://www.endnote.com. The Support and Services section offers an 

extensive FAQ site with options to email the technical support team with your own questions 

 

Your Library staff   

• Robertson Library Reference Desk, telephone 9266 2145. 

• Library Business Team: Kitty Delaney, Jaya Ralph, Claire Murphy, Leanne Thorpe and Jenny Lee. 

Library-business@curtin.edu.au  or telephone 9266 3374. 

 

See the Contact Us details on each Library web page for our email reference services. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This guide has been written using ‘The University of Queensland’s Guide to Using AGLC3 with EndNote X6’: 

http://www.library.uq.edu.au/endnote/aglc/aglc3_ENX6.pdf. Used with permission. 

http://www.endnote.com/
mailto:lis-business@curtin.edu.au

